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Overview of Premiere Elements workspace 
When you start Premiere Elements, the Welcome screen provides three options: 

• The Organize button opens Elements Organizer. In the Organizer you can organize and manage your 
videos, do quick editing, create projects automatically by using these videos, and share the videos. (The 
same Organizer is used with both Photoshop Elements and Premiere Elements.) 

• The New Project button opens the Premiere Elements Editor with a blank project. 

• The Open Project button presents a list of projects that you recently edited. 

 
Figure 1 Premiere Elements Welcome screen 

The Organizer workspace 
Elements Organizer works with both Photoshop Elements and Premiere Elements. The Organizer is available as an 
option on the Welcome screen. 

 

 
Figure 2 Elements Organizer 
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Using the Task pane in the Organizer 
You can perform a number of quick tasks in the Organizer without opening either Premiere Elements or Photoshop 
Elements. 

There are four tabs in the Task pane: 

• Organize: The Organize workspace displays videos and images; you can filter them by date, album, and 
keyword. Find media for your projects, sort through them, assign them keywords so you can find them 
later, and so on. 

• Fix: In the Edit workspace, you can do quick edits on photos, such as fixing redeye or automatically 
adjusting levels. For example, you can quickly apply the Auto Color or Auto Levels command to photos. 

• Create: In the Create workspace, you can quickly begin photo collages, photo books, DVDs, and other 
projects. For example, you can quickly create a DVD menu here. 

• Share: In the Share workspace, you can quickly generate versions of videos and images to share. For 
example, you can share videos online or to another user’s computer or mobile device. 
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Premiere Elements Edit workspace 

 
Figure 3 Premiere Elements Edit workspace 

 

Menu bar: Contains menus for performing tasks, organized by topic. For example, the Timeline menu contains 
commands for navigating through the Timeline. 

Monitor panel: Displays your project at its current playback position. 

Tasks panel: Offers options for organizing, editing, and sharing projects, as well as creating disc menus. 

Timeline and Sceneline: Enable you to add, edit, and view a project as lines or clips. 

Tasks panel workspaces 
The Tasks panel has four tabs that open corresponding workspaces: Organize, Edit, Disc Menus, and Share. 

The Organize workspace 
In the Organize workspace you can import, manage, and organize your projects, clips, and other media. The 
Organize workspace also features an Instant Movie option that automatically creates a movie from clips in the 
Media area. 

• In the Get Media area, you can import video from camcorders, still cameras, webcams, your computer, and 
other media devices. 

• The Media area displays all video clips, audio clips, and still images that have been added to the project. 
You can filter this workspace by album, tag, rating, or media type. Note: At times, depending on your 
computer, you may receive a message indicating that your Media area is too full. If you are not actively 
using media in a project, you can select the media and choose Edit > Clear to remove the media from the 
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Media workspace. This does not delete the media from your computer; if you need to use the media later, 
you can re-import it into Premiere Elements. 

• The Instant Movie area enables you to automatically create a movie from the clips currently in the 
organizer. 

• The Project area lists current projects. 

The Edit workspace 

In the Edit workspace, you can improve the appearance of your clips as well as add effects to your clips. You can 
also add transitions, titles, themes, and clip art to your projects.   

• The Effects view enables you to add effects to your video. Here, you can do everything from adjusting 
color levels to giving your project the appearance of an old film. 

• The Transitions view enables you to add and edit a range of transitions, such as slides, blends, and 
dissolves. 

• The Titles view enables you to add titles and credits to your project, choosing from a range of preformatted 
templates. 

• The Themes view enables you to add a set of preformatted soundtracks, sound effects, backdrops, and titles 
that are all thematically linked. For example, you can choose Halloween themes or Spring themes. 

• The Clip Art view enables you to add clip art to your video, such as animals, tools, costumes, and other 
graphics. 

The Disc Menus workspace 

The Disc Menus workspace enables you to create a disc menu for a DVD or Blu-ray disc. This is the menu that 
appears when a user inserts a disc into a player. You create menus from templates.  

• All templates have at least two buttons: a Menu 1 button and a Scene 1 button. The Menu button enables 
users to return to the menu, and the Scene button enables users to play the movie. You can add more 
buttons by using the Disc Menu workspace.  

• If you have added menu and scene markers in the Timeline, Menu buttons are automatically linked to these 
markers.  

• On some templates, you can drag and drop a still image or video to personalize the menu background. You 
can also personalize a template by changing fonts, colors, backgrounds, and layout. To edit these, you click 
them and change options. 

The Share workspace 

The Share workspace contains everything you need to share your finished project. You can share your project on the 
web or on a DVD, a mobile phone, your computer, and more. 

You can use Quick Share to create and reuse preset sharing options. For example, if you frequently share projects to 
a smart phone, set up your optimal settings for the phone and save those settings as a Quick Share. The next time 
you want to share a project to a smart phone, use the Quick Share preset you created instead of setting all the smart 
phone options again. 

For more information on sharing, see the guide titled “How to share.” 
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How to import video 

There are four basic methods for adding media to your projects: capturing from tape or live sources, importing files 
from other types of storage, adding from the Organize workspace, or recording narrations from a microphone. 

When you add media files to your project, they are added to the Project view and the Organize workspace. Each file 
is represented by a thumbnail, called a clip. Clips, whether they contain audio, video, or still images, are the building 
blocks of your movies. 

Common sources of media files 
To get new media into your project, click Organize in the Tasks panel, and then click Get Media. Use any of the 
following options to add media: 

• DV Camcorder Captures video from a DV camcorder connected by FireWire (IEEE 1394) or USB. This 
option opens the Capture window. 

• HDV Camcorder Captures video from an HDV camcorder connected by FireWire (IEEE 1394). This 
option opens the Capture window. 

• DVD Camcorder Or PC DVD Drive Imports video from your DVD drive, or a DVD in a camcorder 
connected by USB. You can import AVCHD from a DVD Camcorder. This option opens the Video 
Importer dialog box. 

• Flip™, AVCHD, Cameras And Phones Imports media from devices that store video files in flash memory 
or on a disk. Such devices include Flip and other compact video cameras, AVCHD, DVD, DSLR, and other 
still cameras and mobile phones. 

• Webcam Or WDM Device (Webcam in Mac OS)Captures video from a webcam or WDM-compatible 
capture device. This option opens the Capture window. 

• Digital Still Camera & Phones Imports photos from a still camera or mobile phone connected by USB. 
This option opens the Video Importer dialog box. 

• Files And Folders Imports video files, photos, and audio files from your computer’s hard drive. 

File types you can import 
Your choice of footage to include in your movie is not limited to the clips you capture. You can use other image, 
video, and audio files that reside on your computer. You only need to add them to your Adobe Premiere Elements 
project to begin working with them. In some cases, added files can retain a link to the Adobe application in which 
they were created. This allows you to open the file’s original application from within Adobe Premiere Elements, 
make changes, and immediately see the results in Adobe Premiere Elements. 

Except as noted, you can import the following file types by using the Get Media view in the Tasks panel. Added 
files are visible in the Project view in the Tasks panel. 

Video file types 

• AVI Movie (.avi) 

• Flash (.swf) 

• RAW (.raw) 

• Filmstrip (.flm) 

• MPEG Movie (.mpeg, .vob, .mod, .mpe, .mpg, .m2v, .mp2, .mpv, .m2p, .m2t) 

• Windows Media (.wmv, .asf) 
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• QuickTime Movie (.mov, .3gp, .3g2, .mp4, .m4a, .m4v) 

Note: To import video from mobile phones (.3gp and .mp4), you must have the most recent version of QuickTime 
installed on your computer. 

Capturing video 
Use the Capture window to monitor the video and access all of the capture commands (Figure 1). Adobe Premiere 
Elements automatically detects the attached capture device and provides an alert in case of a mismatch. 

This panel includes a video preview area, recording controls, a disk-space indicator, and a timecode display. On the 
right side of the Capture window, you can specify capture settings. 

To open the Capture window, click Organize in the Tasks panel, click Get Media , and select one of the following: 

• DV Camcorder 

• HDV Camcorder 

• Webcam Or WDM Device 

Capturing footage with device control simply means using the controls (Play, Fast Forward, Rewind, Pause, Stop, 
Record, and so on) in the Capture window to control your device, instead of using the controls on the device. Device 
control is a convenient way to locate and capture scenes. 

 

 

 
 

 

Figure 1 Capture window 
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Adding files from tape camcorders 

Capturing involves recording video and audio directly to a hard drive from a DV or HDV camcorder, webcam, or 
other WDM (Windows Driver Model) device. Adobe Premiere Elements automatically detects the attached capture 
device and sets all capture settings accordingly. The Capture window provides controls that let you remotely control 
your device, making it easy to play, capture, pause, and stop the video on your device.  

If you are capturing only a portion of a tape, as opposed to capturing an entire tape, capture at least 3 seconds of 
additional footage (called handles) at both the beginning and end of the segment to provide a margin of error during 
capture. Handles also allow for cleaner transitions and more flexibility when you trim your clips. 

To capture clips from a camcorder 

1. Do one of the following, depending on the capture 
device you are using: 

• Connect the DV camcorder , HDV camcorder, 
Webcam, WDM device, or analog device to your 
computer by connecting a cable to the USB 2.0 port 
or 1394 (FireWire) port.  

• Consult the owner’s manual for your computer for 
details on these and other options. 

2. Turn on the camcorder and set it to playback mode, 
which may be labeled either VTR, VCR, or Play. You 
can also keep it in recording mode. 

3. Click Organize, and then click Get Media  (Figure 2).  

 A list of devices appears. 

4. Click DV Camcorder, HDV Camcorder, or Webcam Or 
WDM Device. 

 Adobe Premiere Elements automatically detects your 
attached device and provides an alert in case of a 
mismatch.  

 The Capture window opens.  

If you have more than one device attached, select the 
device from the Capturing Source menu. 

5. Enter a name for the clip. 

6. Browse for a location to save the clip. 

7. Set the following options as desired in the Capture 
window (Figure 3): 

• Capture Video or Audio: By default, both are 
selected. 

• Capture To Timeline: Clips are automatically added 
to the Timeline after you finish capturing them 

• Split Scenes: Capture is split into clips by either 
Timecode or Content. 

8. Using the controls in the Capture window, rewind or 
advance the tape to the desired position. 

 
Figure 2 List of import devices in Organize 
workspace 

 

 
Figure 3 Options for capturing video from a 
camcorder 
 
 



Adobe Premiere Elements 9 guide 

4 How to import video © 2010 Adobe Systems Incorporated 

 

9. Click the Capture button.  

 Premiere Elements begins capturing video from the 
camcorder (Figure 4). 

10. When you have finished capturing, click the Pause 
button.  

 Depending on the options you selected, the Auto 
Analyzer runs and the captured clips are added to the 
Organize workspace and/or the Timeline. 

 

 
 

Figure 4 Capture window 

Add videos using the Video Importer 
Many types of devices other than DV camcorders record and store video. Using the Video Importer (Figure 5), you 
can import files from tapeless camcorders and mobile devices, and from removable media, such as DVDs, memory 
cards, and multimedia cards. These files are copied to the hard drive location you specify and added to the Organize 
workspace and Project view. 

Ensure that the footage you add to a project matches the project preset. In a mismatch, a dialog box appears 
informing you of the mismatch. Using the dialog box you can choose to let Adobe Premiere Elements change 
project settings to match your clips. 

Note: Image files cannot be imported. For photographs, use the Digital Still Camera And Phones option. 

 

 

 
Figure 5 Video Importer 
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To use the Video Importer: 

1. Connect the media by doing one of the following: 

• Place a DVD in your computer’s DVD drive. 

• Connect the digital camera, mobile phone, or other 
device to your computer by connecting a cable to 
the USB 2.0 port.  

• Consult the owner’s manual for your computer for 
details on these and other options. 

2. In the Organize workspace, click Get Media (Figure 6).  

 A list of devices appears. 

3. Click the device from which you want to import: 

• DVD Camcorder Or PC DVD Drive 

• Flip, AVCHD, Cameras, And Phones 

 Note: If you have an SD card reader or other card reader 
attached to your computer, choose Files And Folders to 
browse for the card reader. 

The Video Importer dialog box appears (Figure 7). 

4. In the Source Menu, select the device from which you 
want to download movie clips. 

The contents of the device or disk are displayed in the 
panel below the Source menu. The number of files and 
the size of the content is displayed at the bottom of the 
panel containing the content. 

5. Do one of the following: 

• To import all the content displayed in the panel, 
click Check All. 

• To import a few clips, click UnCheck All, and 
select only those clips that you want to import. 

Thumbnails of all importable files appear in the dialog 
box. 

Note: To preview the contents of a clip, click the clip, 
and then click the Play button in the Preview panel 
(Figure 7). 

 

 
Figure 6 Organize workspace 

 

 
 

 

Figure 7 Video Importer dialog box 
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6. To specify a location for the saved files, do one of the 
following: 

• To save files to the default Adobe folder in the My 
Videos folder, leave the location as it appears in the 
dialog box. 

• To specify a different location, click Browse and 
choose a folder or click Make New Folder to create 
and name a new folder. 

7. Select a naming convention for the downloaded files 
using the Presets menu. 

File Name Retains the filenames assigned by the 
camcorder. 

Folder Name - Number If your folder name is Class 
Assignment, the clips are assigned the names Class 
Assignment - 001, Class Assignment - 002, and so on. 

Date - File name Adds a timestamp to the filename 
assigned by the camcorder. The timestamp is the current 
date and time - the date and time on which the movies 
were transferred to your computer. 

Note: To rename files, delete them from the Organizer, 
and then re-import them. 

Custom Name - Number Enter a custom name in the 
Name text box. For example, if you enter My Holiday in 
the text box, the clips are named My Holiday-001, My 
Holiday-002, and so on. 

8. (Optional) Other settings to consider include the 
following: 

• If you want to delete the selected files in the camera 
after import, select the option After Copying Delete 
Originals. 

• If you do not want the imported clips added to the 
timeline after import, deselect Add To Timeline. 
The imported clips are added only to the Organizer. 

• If you want to create an InstantMovie using the 
selected clips, select Create InstantMovie. 

9. Click Get Media. You can click Cancel in the Progress 
dialog box at any time to stop the process. 

 Note: If you don’t intend to use all the files you add, 
you can delete them from the Project view. Deleting 
files from the Tasks panel doesn’t delete them from your 
hard drive. This practice is recommended for large VOB 
files. 
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How to edit clips 

Editing clips includes previewing and trimming them to eliminate unnecessary material. It could also include 
revising clip properties such as speed, direction, and duration. If you have media clips generated by other programs, 
you can also edit them in their original applications from within Adobe Premiere Elements. 

This guide covers the following topics: 

• Working with the Preview window 

• Trimming a clip in the Monitor panel 

• Removing frames from the middle of a clip in the Sceneline 

• Editing clips on the Timeline 

• Applying auto quality enhancements 

• Editing multiple clips 

• Using Freeze Frame to export images 

The Preview window 
Although the Timeline is the primary workspace for assembling clips into movies, the Preview window (Figure 1) 
provides a helpful workspace for viewing clips, setting their In and Out points, and adding markers to clips and 
movies. Double-click any clip in Project view to launch the Preview window. The time ruler graphically represents 
the full duration of a clip or movie. 

 
Figure 1 The Preview window 

Showing the docking headers 
Each panel has a docking header containing its title, and sometimes, panel menu buttons. You drag the docking 
headers to drag panels to new locations. To save space on your screen, you can make the docking headers disappear; 
then, make them reappear when you need to use them. By default, docking headers are hidden. 
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To display and hide docking headers: 

Do one of the following: 

 To make docking headers appear, choose 
Window > Show Docking Headers. 

 To make docking headers disappear, choose 
Window > Hide Docking Headers. 

 

Note: To access any of the commands in the panel menu when docking headers are hidden, right-click in the panel. 

Editing tools 
You use the editing tools in the Timeline and in the Monitor panel to trim clips, split them, and change their speed 
(Figure 2). When you edit on the Timeline, the pointer changes to the currently active tool. If the pointer changes to 
a red slash, you cannot use the tool on the clip under the pointer. 

Selection tool: Selects clips for previewing or trimming. 

Time Stretch tool: Changes the playback speed and duration of a clip without changing its In or Out points. 
Dragging the edge of a clip in one direction lengthens it and slows it down; dragging in the other direction shortens 
the clip and speeds it up. 

Split Clip tool: Splits the selected clip or clips at the current-time indicator. Be sure to select only the clips you want 
split before you click the Split Clip tool. If no clips are selected, the Split Clip tool cuts all tracks at the current-time 
indicator. 

 
Figure 2 Editing tools in the Timeline and the Monitor panel 
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Zooming into or out of the Timeline 
When you zoom in on the Timeline, Adobe Premiere Elements magnifies the Timeline around the current-time 
indicator, letting you examine smaller increments of media. You can also zoom in as you add a clip to the Timeline, 
magnifying the location around the pointer rather than the current-time indicator. This technique lets you better see 
the placement of the insertion before you release the mouse. In contrast, zooming out shows more of the Timeline, 
giving you a visual summary of the movie. 

To zoom into or out of the Timeline: 

1. In the My Project panel, click Timeline. 

2. Do one of the following: 

 To zoom in or out as you add a clip, drag a clip to 
the Timeline. Hold down the mouse button and 
press the Plus (+) key to increase the zoom factor or 
press the Minus (–) key to decrease it until you have 
zoomed as far as you want to go. 

 To zoom in on the Timeline, drag the Zoom slider 
to the right or click the Zoom In button. 

 To zoom out of the Timeline, drag the Zoom slider 
to the left, or click the Zoom Out button (Figure 3). 

Note: To zoom out so the entire length of the movie is 
visible in the Timeline, make sure the Timeline is active, and 
then press the Backslash (\) key. You can also zoom in and 
out by pressing the Plus (+) or Minus (–) keys on the 
keyboard (not the numeric keypad). 

 

 
Figure 3 Zoom controls in the Timeline 

 

Zoom controls 
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To position the current-time indicator: 

In either the Preview window or the Timeline, do any of the 
following. 

 Drag the current-time indicator (Figure 4). 

 Click the time ruler where you want to position the 
current-time indicator. 

 Press Shift while dragging the current-time 
indicator to snap it to the edge of the closest clip or 
marker (Timeline only). 

 Drag the time display to the desired time value 
(Figure 5). 

 Click the time display, type a valid time, and then 
press Enter. (You don’t need to type leading zeros, 
colons, or semicolons. However, be aware that 
Adobe Premiere Elements interprets numbers less 
than 100 as frames.) 

 In the mini-timeline in the Monitor panel, use any 
playback control. (The mini-timeline is visible in 
the Monitor panel when you use the Sceneline.) 

Note: You can use the Home or End keys on the keyboard to 
skip back to the beginning or ahead to the end of the movie. 
The Page Up and Page Down keys go to the previous and 
next clips. The Right Arrow and Left Arrow keys move the 
current-time indicator forward or back a frame, and pressing 
Shift+Right Arrow or Shift+Left Arrow moves the indicator 
in increments of five frames. 

 
 

Figure 4 The current-time indicator in the 
Timeline 

 

 
 

Figure 5 The time display  
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Trimming clips 
You can build movies in several ways, but all of them involve selecting the portions of source clips you want to 
include. You rarely use an entire clip. In and Out points define the first and last frames you want to use from a clip 
(Figure 6). Setting In and Out points does not actually delete frames from the hard drive but instead isolates the 
portion of the clip you want included in the movie. In a manner of speaking, In and Out points open a window over 
the clip, showing only the part you select. You can move the points as needed to regain any frames you might have 
trimmed off. 

 
 

 

Figure 6 In and Out points serve as a window over a clip 

You always trim from either end of a clip. To trim frames from the middle of a clip, you must first split the clip 
(which creates two instances of the original clip) and then trim the unwanted frames from the end of the first new 
clip or the beginning of the second. You can trim a clip by clicking the Set In and Set Out buttons in the Preview 
window, by dragging handles in the Monitor panel while viewing the Sceneline, or by dragging the ends of the clip 
in the Timeline. 

Previewing and trimming in the Preview window 
You can preview any clip and set new In and Out points for it before arranging it with others in the My Project 
panel. You might, for example, preview your clips to determine their quality and trim off their unusable parts before 
starting to arrange them. You can preview and trim clips in the Preview window (Figure 7). 

Trimming a clip in the Preview window sets its In and Out points for all subsequent instances placed in the My 
Project panel. It does not change the In and Out points of instances of the clip already in the My Project panel before 
the trimming. 

 
 

 
 

Figure 7 Preview window  
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To preview a clip in the Preview window: 

1. Open the Media in the Tasks panel. 

2. Double-click a clip in the Media view (Figure 8). 

The clip appears in the Preview window. 

3. Do any of the following in the Preview window: 

 To play the clip, click the Play button. 

 To step back or forward one frame, click the Step 
Back button or the Step Forward button. 

 To step back or forward five frames, Shift-click the 
Step Back button or the Step Forward button. 

 

 
Figure 8 Project view in the Tasks panel 

Trimming a clip in the Preview window 
You can trim a clip in the Preview window before placing it into the My Project panel. The Set In and Set Out 
buttons mark the start and end frames of the clip. Once a clip is in a movie, you can reopen it in the Preview window 
to change its In and Out points for subsequent instances, either regaining frames previously trimmed or trimming 
additional frames. 

To trim a clip in the Preview window: 

1. Click the Organize tab. 

2. Double-click a clip in the Media view. 

The clip appears in the Preview window. 

3. To trim the clip, do any of the following in the Preview 
window: 

 To set a new In point, either drag the In point 
handle to the desired location or drag the current-
time indicator to the desired location and click the 
Set In button. 

 To set a new Out point, either drag the Out point 
handle to the desired location or drag the current-
time indicator to the desired location and click the 
Set Out button (Figure 9). 

4. Click the Close button in the Preview window. 

Note: Subsequent instances of the clip dragged from the 
Project view will assume the In and Out points of the 
trimmed clip. Trimming in the Preview window will not 
affect instances of the clip already in the My Project panel 
before trimming. 

 
Figure 9 Set In and Set Out buttons in the Preview 
window 
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Zooming in and out in the Preview window 
When previewing a clip in the Preview window, you can zoom in or out of its time ruler to expand or contract its 
increments. Zooming in on the time ruler helps you see changes happening over small expanses of time, even over 
the duration of a single frame. Zooming out helps you see changes happening over longer spans. 

To zoom in and out in the Preview window: 

 To zoom in on the time ruler, drag either end of the 
Zoom control toward the center (Figure 10). 

 To zoom out on the time ruler, drag either end of the 
Zoom control out toward the edge of the ruler. 

 

 
Figure 10 Zoom control in the Preview window 

Trimming a clip in the Monitor panel 
When the My Project panel is in the Sceneline view, you can trim clips directly in the Monitor panel. 

To trim a clip in the Monitor panel: 

1. In the My Project panel, click Sceneline. 

2. Select a clip in the Sceneline (Figure 11). 

The clip appears in the Monitor panel, with a clip 
representation containing the clip’s filename on the time 
ruler of the Monitor panel. 

3. Do one of the following: 

 To trim the clip from the beginning, drag the In 
point handle on the left of the clip representation to 
the right. 

 To trim the clip from the end, drag the Out point 
handle on the right of the clip representation to the 
left (Figure 12). 

The Monitor panel shows two frames: on the left, the 
clip with the location of the handle you drag, as well as 
the beginning of the next clip. 

 
Figure 11 My Project panel, Sceneline view 

 

 
Figure 12 Drag the Out point to trim a clip in the 
Monitor panel 

Zoom control 
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Removing frames from the middle of a clip in the Sceneline 
You may want to retain material at the beginning and end of a clip for your movie but remove material from its 
middle. You can split the clip right before the unwanted section begins and then trim the unwanted material from the 
beginning of the newly created second clip. 

To remove frames from the middle of a clip in the Sceneline: 

1. In the My Project panel, click Sceneline. 

2. Select the clip containing unwanted material in the 
Sceneline. 

The clip appears in the Monitor, with a clip 
representation containing its filename in the time ruler 
of the Monitor. 

3. Drag the current-time indicator in the Monitor to the 
frame where the unwanted material begins. 

4. In the Monitor, click the Split Clip tool (Figure 13). 

Two clip representations replace the original in the time 
ruler of the Monitor, and two clips replace the original in 
the Sceneline. 

5. Select the representation of the second clip in the time 
ruler of the Monitor. 

6. Drag the Set In handle of the clip representation to the 
right, and drop it past the unwanted material. 

The unwanted material is removed from the beginning 
of the second clip, and the gap created between the first 
and second clips is automatically closed (Figure 14). 

 
 

Figure 13 Place the current-time indicator at the 
split point, and click the Split Clip tool 

 

 
Figure 14 Two trimmed clips replace the original 
in the Sceneline 

Split Clip tool 
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Editing clips on the Timeline 
You can remove or regain trimmed frames from either end of a clip by dragging the clip’s edge in the Timeline. To 
help you locate the precise frame you want, the Monitor panel displays the frame at the changing In or Out point of 
the clip as you drag. If a clip has another clip immediately adjacent to the edge you’re trimming, the Monitor panel 
displays the frames of both clips side-by-side. The frame on the left (the Out point) is earlier in time, and the frame 
on the right (the In point) is later in time. Subsequent clips in the Timeline shift as you drag the clip’s edge. When 
you are trimming frames, empty space adjacent to the trimmed edge shifts in time just as a clip would. 

A pop-up window displays the amount of time you are trimming as you trim them (Figure 15). This window 
displays a negative value if you drag the edge toward the beginning of the movie and a positive number if you drag 
toward the end of the movie. 

 
Figure 15 Timeline during trimming 

For linked clips (video that includes a soundtrack), dragging the edge of one clip changes the In or Out points of 
both clips. Sometimes you want to trim linked clips independently to create split edits (also known as L-cuts and 
J-cuts). Pressing Alt (Windows) or Option (Mac OS) when you trim allows you to set the In and Out points of the 
video and audio separately. 

To trim clips in the Timeline: 

1. In the My Project panel, click Timeline. 

2. Click the Selection tool. 

Note: To trim only one clip of a linked pair, Alt-select 
the clip to temporarily unlink them. Select them again to 
move them as a unit. 

3. Position the pointer over the edge of the clip you want to 
trim until the correct icon appears: 

 Trim-In icon to trim the beginning of a clip 
(Figure 16) 

 Trim-Out icon to trim the end of a clip 

4. Drag the edge to the desired frame.  

 Notice that the Monitor panel displays the frames as you 
drag, also showing the frame from the adjacent clip 
(Figure 17). Subsequent clips in the track shift in time 
to compensate for the edit, but their durations remain 
unchanged. 

Note: You cannot drag the In point of a clip to the left 
past the edge of an adjacent clip. 

 
Figure 16 Trim-In icon indicates trimming from 
the beginning of a clip 

 

 
Figure 17 Adjacent frame and trimmed frames are 
both visible in Monitor to help with trimming 
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Using Smart Trim 
The Smart Trim mode automatically analyzes clips on the Timeline, identifying problems such as low contrast, too 
shaky, too dark, or blurry. 

To use Smart Trim: 

1. In the My Project panel, click Timeline. 

2. Click the Smart Trim Mode icon (Figure 18). 

 Premiere Elements switches to Smart Trim mode. You 
may see the message “Analyzing Media.” 

 Smart Trim highlights clips with problems.  

3. Position the pointer over any highlighted area until a 
message appears, such as “Blurred, Shaky” (Figure 19). 

4. To trim the problem segment, position the pointer over 
the edge of the highlighting until the trim icon appears. 

5. Drag the pointer to the end of the highlighted area.  

 The problem area is removed from the Timeline. 

6. Click the Smart Trim Options button at the top of the 
Monitor. 

 The Smart Trim Options dialog box opens (Figure 20). 

7. Drag one of the sliders to the left to adjust Quality Level 
or Interest Level. 

 Observe that the highlighted areas change. For example, 
if you reduced the Quality Level, you will likely see 
fewer highlighted areas on the Timeline. 

 

 

 

 

 

 
 

Figure 18 Timeline 

 

 
Figure 19 Problem segment identified by Smart 
Trim 

 

 
Figure 20 Smart Trim dialog box 

Smart Trim Mode Icon 
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About splitting clips 
At times you may want to apply different effects to different parts of a clip. For example, you may want to speed up 
the first part of it while leaving the second part at normal speed. To do this, you cut a clip into separate pieces and 
then apply effects and transitions to those pieces. You can split a clip in a movie by using the Split Clip tool to cut 
one or more selected clips at the current-time indicator. 

Splitting a clip creates a new and separate instance of the original clip and, if linked to another clip, a new instance 
of the linked clip as well. The resulting clips are full versions of the original clip but with the In or Out point 
changed to match the location marked by the tool (Figure 21). You can select and delete these clips. 

Note: If you want to change effect settings over time, you don’t have to split the clip. You can apply keyframes to a 
single clip instead. 

 
Figure 21 Timeline view showing split Clip tool before (left) and after (right)  

cuts selected clips at the current-time indicator 

Splitting a clip 

You can split a clip at any frame, creating one clip that ends and another that begins at that frame. You can edit the 
two resulting clips as you would any other clips. 

To split a clip: 

1. In the My Project panel, click either Sceneline or 
Timeline and select a clip in the Sceneline or the 
Timeline. 

The clip selected appears in the Monitor panel. 

2. Do one of the following: 

 If you chose Sceneline, drag the current-time 
indicator in the Monitor to the frame where you 
want to create the split (Figure 22). 

 If you chose Timeline, drag the current-time 
indicator in the Timeline to the frame where you 
want to create the split. 

3. In the Monitor, click the Split Clip tool. 

Two new clips take the place of the original clip in the 
My Project panel, one ending and one beginning at the 
location of the current-time indicator. 

 
 

Figure 22 In the Sceneline view, drag the current-
time indicator in the Monitor 

 

Split Clip tool 
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Using Time Stretch 
At times, you may want to stretch out a clip to match an audio track or for other reasons. To do so, you first need to 
drag the clip to the end of the movie or to another track with sufficient space, so that you do not bump up against 
another clip when you are stretching the clip. You can also use Time Stretch for images. When you apply Time 
Stretch to an image, the image is displayed for more time. 

To apply Time Stretch to a clip: 

1. In the My Project panel, click Timeline. 

2. Move the clip to the end of the movie or to another track 
with sufficient space to hold the stretched clip. 

3. Click the Time Stretch tool at the top of the Timeline 
(Figure 23). 

4. Position the pointer over the edge of the clip you want to 
stretch until the correct icon appears: 

• Time Stretch In icon to time stretch the clip to the 
left of the pointer. 

• Time Stretch Out icon to time stretch the clip to the 
right of the pointer. 

5. Drag the edge of the clip to extend or shorten it 
(Figure 24).  

 Extending the clip will slow down the action in the clip, 
while shortening the clip will speed up the action. 

 As you stretch the clip, Premiere Elements indicates by 
how much time the clip is changing. 

6. Rewind the clip and click Play to preview your changes. 

7. Shorten or lengthen the clip as necessary. 

8. If you moved the clip in step 2, you can now use the 
Selection tool to drag the clip back into place. 

 
 

Figure 23 Clip positioned for Time Stretch 

 

 
 

 

Figure 24 Stretching the clip 

Time Stretch tool 

Time Stretch  
Out icon 

Amount clip is 
changing 
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To apply Time Stretch to an image: 

1. In the My Project panel, click Timeline. 

2. Move the image to the end of the movie or another track 
with sufficient space. 

3. Click the Time Stretch tool at the top of the Timeline. 

4. Position the pointer over the edge of the image you want 
to stretch until the correct icon appears: 

• Time Stretch In icon to time stretch the image to the 
left of the pointer. 

• Time Stretch Out icon to time stretch the image to 
the right of the pointer. 

5. Drag the edge of the image to extend or shorten it on the 
Timeline.  

 Extending it will cause the image to appear for more 
time, while shortening it will cause the image to appear 
for less time. 

 As you stretch the image, Premiere Elements indicates 
by how much time the clip is changing (Figure 25). 

6. Rewind the clip and click Play to preview your changes. 

7. Shorten or lengthen the image as necessary. 

8. If you moved the image in step 2, you can now use the 
Selection tool to drag the image back into place. 

 
Figure 25 Stretching the image 
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Applying auto quality enhancements 
Premiere Elements provides a number of effects that enable you to quickly enhance the quality of a clip.  

• Auto Color adjusts color levels and contrast, limiting the overall range of black and white pixels. It can 
quickly improve many clips. 

• Auto Contrast sharpens the overall contrast—the difference between light and dark colors—without 
introducing or removing color casts.  

• Auto Levels automatically reduces both highlights and shadows. That is, it makes light areas slightly darker 
and dark areas slightly lighter. Auto Levels adjusts each color channel individually. In some cases, it may 
add a slight tint to a clip. You can remove this tint by undoing the effect. 

All effects are reversible, so if you don’t like the results of an effect, you can remove the effect at any point. 

To apply Auto Color, Auto Contrast, or Auto Levels: 

1. Click the Edit tab in the Tasks panel. 

2. Click the Effects button. 

 The Effects view opens. Auto Color, Auto Contrast, and 
Auto Levels appear in the top row of effects 
(Figure 26). 

3. Click Auto Contrast to select it. 

4. Click the Apply button to apply the effect. 

 Observe that the clip changes slightly and that Auto 
Contrast appears next to the clip preview in the Edit 
workspace (Figure 27). If you are pleased with the 
change, save the file. 

5. To remove the effect at any time, click the applied effect 
in the Edit workspace and click the Delete icon. 

 

 

 
Figure 26 Effects view 

 

 
 

Figure 27 List of applied effects 

Effects applied 
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Editing multiple clips 
You can edit multiple clips by first selecting them in the Timeline and then applying one or more of the following 
commands. 

 Apply default transition to multiple clips 

 Apply effects to multiple clips 

 Change the speed and duration of multiple clips in one operation 

 Adjust audio gain for multiple clips  

To apply effects or transitions to multiple clips: 

1. In the My Project panel, click Timeline. Make sure there 
are multiple clips on the Timeline. 

2. Click the Select tool. 

3. While holding down the Shift key, click to select 
multiple clips (Figure 28). 

4. Choose an effect or transition in the Edit workspace of 
the Tasks panel. 

 Premiere applies the effect or transition to the selected 
clips. 

 
Figure 28 Selecting multiple clips 
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Using Freeze Frame to export images 
At times, you may want to extract a still image from a video. You can do so by using the Freeze Frame command.  

To export an image: 

1. In the Timeline, drag the current-time indicator to the 
frame you want to capture (Figure 29). 

2. Click the Freeze Frame button. 

 The Freeze Frame dialog box opens (Figure 30). 

3. Click the Export button. 

4. Browse for a location to store the image and enter a 
name for it. 

 Note: You can also insert the still image into the movie. 
If you do so, you can first set a duration for the image to 
appear in the movie by dragging over the Freeze Frame 
Duration number. 

 
 

 

Figure 29 Current-time indicator positioned for 
Freeze Frame 

 

 
Figure 30 Freeze Frame dialog box 

 

Current-time 
indicator 

Freeze Frame 
button 
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How to add transitions 
By using transitions, you can phase out one clip while phasing in the next, or you can stylize the beginning or end of 
a single clip. A transition can be as subtle as a cross dissolve or quite emphatic, such as a page turn (Figure 1) or 
spinning pinwheel. You generally place a transition on a cut to include clips on either side—a double-sided 
transition, but you can also apply a transition to just the beginning or end of a clip—a single-sided transition. 

 
Figure 1 Page Peel transition between two clips (left) and Cross Dissolve transition at end of clip (right) 

For a transition to shift from one clip to the next, the transition must overlap frames from both clips. To achieve the 
overlap, transitions can use frames previously trimmed from the clips, if any exist (frames just past the In or Out 
point at the cut), or they can repeat the frames on either side of the cut. It’s important to remember that when you 
trim a clip, you don’t delete frames. The resulting In and Out points simply frame a window over the original clip. A 
transition uses the trimmed frames to create the transition effect (Figure 2), or, if the clips don’t have trimmed 
frames, the transition repeats frames (Figure 3). 

 
Figure 2 Transition using trimmed frames to shift to the next scene  

A. First clip with trimmed frames at end B. Movie containing clips and transition  
C. Second clip with trimmed frames at beginning 

 
Figure 3 Transition repeating frames for clips without trimmed frames  

A. First clip showing last frame repeated B. Movie containing both clips and transition  
C. Second clip showing first frame repeated 
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Where to access transitions 
Available transitions are listed in the Edit workspace in the Tasks panel (Figure 4) and are organized into two main 
categories, Video Transitions and Audio Transitions. Video transitions have corresponding animated thumbnails that 
show how they affect clips. Select a transition to set its thumbnail in motion. 

 
Figure 4 Transitions view in the Tasks panel 

You can narrow a search for transitions by choosing a transition type, such as Dissolve, from the category menu. 
You can also search for a transition by typing its name in the search box. If you use a transition frequently, you can 
right-click it and choose Set Selected as Default Transition. You can then quickly find all your frequently used 
transitions in the Favorites folder. 

Note: Adobe Premiere Elements includes two audio transitions in the Crossfade category, Constant Power and 
Constant Gain. Though both provide fades, they differ slightly. Constant Power creates a smoother-sounding fade, 
while Constant Gain, though mathematically linear, often sounds abrupt. 
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Transition appearance in the Sceneline and the Timeline 
In the Sceneline, a transition appears as a rectangle between two clips. In the Timeline, a transition appears just 
above the cut between two clips, or just above the In or Out point of a single clip (Figure 5). 

 

 

 
Figure 5 Transitions in the Sceneline (above), transitions in the Timeline (below) 

Applying double-sided and single-sided transitions 
Transitions that gradually replace one clip with another are called double-sided transitions. Those that affect only a 
single clip, such as a Dip to Black, are called single-sided.  

Double-sided transitions occur between clips and are typically used to leave the first clip while introducing the 
second. A single-sided transition occurs at the beginning or end of a clip (Figure 6). These transitions are typically 
used to fade to black or to let a second clip show through the first.  

 

 
 

Figure 6 Types of transitions 
A. Double-sided transition B. Single-sided transition 

 

If neither clip has extra frames, Adobe Premiere Elements applies a Center At Cut transition, which combines the 
last frames of the first clip with the first frames of the second. From the beginning of the transition, it repeats, or 
duplicates, the first frame of the second clip until the cut line. Following the cut line, it repeats the last frame of the 
first clip to the end of the transition. 
 

A B 
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To apply a double-sided transition in the Sceneline: 

1. Open an Adobe Premiere Elements project and 
confirm the Sceneline is open. 

2. In the Tasks panel, click Edit, and then click the 
Transitions button to open the Transitions view. 

3. From the menus in the Transitions view, select Video 
Transitions, and then select the category containing 
the transition you want to apply (Figure 7). 

4. Drag the transition from the Tasks panel to a rectangle 
between two clips in the Sceneline (Figure 8).  

 An icon of the transition fills the rectangle. 

5. Double-click the rectangle to preview the transition. 

 
Figure 7 Transitions category menu 

 

 
Figure 8 Dragging a transition into the 
Sceneline 
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Applying a double-sided transition in the Timeline 
To apply a transition between two clips in the Timeline the clips must be on the same track, with no space between 
them. If a double-sided transition must use repeated frames (rather than trimmed frames), the transition icon 
contains additional diagonal lines. The lines span the area where it has used the repeated frames. 

To apply a double-sided transition in the Timeline: 

1. In the Tasks panel, click Edit, and then click Transitions. 

2. In the My Projects panel, click Timeline. 

3. From the menus in the Transitions view, select Video 
Transitions, and then select the category containing the 
transition you want to apply. 

4. Drag the transition from the Tasks panel to the cut 
between two clips in the Timeline, and release the 
mouse button when one of the following pointers 
appears: 

 Start At Cut icon : Aligns the beginning of the 
transition to the beginning of the second clip. 

 Center At Cut icon : Centers the transition over 
the cut (Figure 9). 

 End At Cut icon : Aligns the end of the 
transition to the end of the first clip. 

Note: Dragging a transition allows you to select Start At 
Cut, Center At Cut, or End At Cut by slowly dragging 
the transition left and right over the cut. 

 
Figure 9 Dragging a transition onto the Timeline, 
with Center At Cut icon visible at pointer 



Adobe Premiere Elements 9 guide 

6 How to add transitions © 2010 Adobe Systems Incorporated 

To apply a single-sided transition in the Sceneline: 

1. In the Tasks panel, click Edit, and then click Transitions. 

2. In the My Projects panel, click Sceneline. 

3. From the menus in the Transitions view, select Video 
Transitions, and then select the category containing the 
transition you want to apply. 

4. Do one of the following: 

 If the clip has no clip adjacent to one side of it, drag 
the transition to the transition rectangle on that side 
of the clip. 

 If the clip is adjacent to another clip, drag the 
transition between the two clips. In the Sceneline, 
click the Properties button (Figure 10) and from the 
Alignment menu, select either Start At Cut or End 
At Cut (Figure 11). 

 

 
Figure 10 Properties button in Sceneline 

 

 
Figure 11 The Alignment menu in the Transition 
properties view 

Properties 
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Applying a single-sided transition in the Timeline 
When you create a single-sided transition, whatever is below the transition in the Timeline appears in the transparent 
portion of the transition. For example, if you want the clip to transition to black, it must be on track 1 or have no 
clips beneath it. If the clip is on a track above another clip, the clip on the lower track appears in the transition, so 
the transition will appear to be double-sided. 

To apply a single-sided transition in the Timeline: 

1. In the Tasks panel, click Edit, and then click Transitions. 

2. In the My Projects panel, click Timeline. 

3. From the menus in the Transitions view, select Video 
Transitions, and then select the category containing the 
transition you want to apply. 

4. Do one of the following: 

 If the clip has no adjacent clip to one side of it, drag 
the transition to the edge of the clip. 

 If the clip is adjacent to another clip, drag the 
transition to the edge of the desired clip 
(Figure 12). 

 Note: The appearance of the pointer will differ, 
depending on start options selected for the transition. 

 
Figure 12 Dragging a transition onto the 
Timeline, with Start At Cut icon visible at pointer 
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Previewing a transition prior to applying it 
Animated thumbnails in the Transitions view enable you to preview any transition without having to apply it to a 
clip. 

To preview a transition before you apply it: 

1. In the Tasks panel, click Edit, and then click Transitions. 

2. Click a thumbnail to set it in motion (Figure 13). 

 

 
Figure 13 Animated thumbnail  

Previewing an applied transition 
You can preview transitions you’ve applied from either the Properties view or the Monitor panel. The Properties 
view provides a preview area where you can display thumbnails of the actual clips or the default thumbnails (the 
letters A and B) (Figure 14). All adjustments to transitions are performed in the Properties view, so if you plan to 
adjust it as you preview it, use the Properties view. 

 
Figure 14 Applied transition in Properties view 

Transition preview 

Show Timeline 
Clip A 

Clip B 

Transition 

Current time indicator 

Show Actual Sources 

Start and end frames 

Start and end sliders 
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To preview an applied transition: 

1. Select the transition in the Timeline. 

2. In the Transitions view of the Tasks panel, click the Edit 
Transition button. 

3. In the Properties view, click Show Timeline if the 
Properties timeline is hidden (Figure 14). 

4. To display the actual clips in the preview area, select 
Show Actual Sources. (You may need to lengthen the 
panel to locate this option.) 

5. Do any of the following: 

  To preview the transition in the Properties view, 
click the Play button next to the thumbnail 
(Figure 15). Click the button again to stop the 
preview.  

  To preview the transition in the Monitor panel, 
move the current-time indicator (in either the 
Timeline or the Properties view) to the left of the 
transition, and then click the Play button in the 
Monitor panel (Figure 16). 

  To preview a particular frame of the transition in 
the Monitor panel, drag the current-time indicator 
(in either the Timeline or the Properties view) to the 
desired frame. 

Note: If you have a digital camcorder, you can probably 
connect it to both your computer and TV to see real-time 
previews on the TV monitor. 

 
 

Figure 15 Properties view with Page Peel 
transition 

 

 
Figure 16 Previewing transition in Monitor panel  

Play button Current time indicator 
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Specifying a default transition 
The default transition is used in slide shows you create, files you import from Adobe® Photoshop® Elements, and 
motion backgrounds you create for DVD menus. The default transitions are Cross Dissolve for video and still 
images and Constant Power for audio, but you can change these defaults. 

To specify a default transition: 

1. In the Tasks panel, click the Edit tab, and then click 
Transitions.  

2. Right-click (Windows) or Control-click (Mac OS) the 
transition you want to be the default, and choose Set 
Selected As Default Transition (Figure 17).  

 
Figure 17 Set Selected As Default Transition 
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Controls and options for adjusting transitions 
All transitions have properties you can adjust in the Properties view (Figure 18). Common properties are the 
location of the center point, the start and end values, the border, and the anti-aliasing quality setting. (For some 
transitions, you can also change the orientation.) The following list describes the most common controls and options 
you can use to adjust transition properties.  

To open the Properties view, click the Edit Transition button in the Transitions view. 

• Duration: Sets the duration of the transition. The default duration is one second. 

• Alignment: Controls how the transition is aligned between clips. By default, transitions are centered 
between clips. 

• Directional selectors: Change the orientation of the transition. For example, the Barn Doors transition can 
be oriented vertically or horizontally. Click a directional selector—one of the small arrows that surround 
the small thumbnail in the preview area—to change the orientation. A transition doesn’t have directional 
selectors if it has one orientation or if orientation isn’t applicable. 

• Start and End sliders: Set the percentage of the transition that is complete at the start and end of the 
transition.  

• Show Actual Sources: Displays the starting and ending frames of the clips. 

• Border Width: Adjusts the width of the optional border on the transition. The default border is None. Some 
transitions do not have borders.  

• Border Color: Specifies the color of the transition’s border. Double-click the color swatch or use the 
eyedropper to choose the color. 

• Reverse: Plays the transition backward. For example, the Clock Wipe transition plays counterclockwise. 

• Anti-Aliasing Quality: Adjusts the smoothness of the transition’s edges. 

• Custom: Changes settings specific to the transition. Most transitions don’t have custom settings. 

 

  
Figure 18 Transitions in Transitions view (left) and Properties view (right) 
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To adjust the transition duration: 

Select the transition in the Timeline, and do one of the 
following: 

 Position the pointer over the end of the transition 
until the Trim-In icon  (Figure 19) or the Trim-
Out icon  appears; then drag. 

 Select the transition to display it in the Properties 
view. (If the mini-timeline in the Properties view is 
hidden, click Show Timeline.) In the Properties 
mini-timeline, position the pointer over the 
transition until the Trim-In icon or the Trim-Out 
icon appears; then drag. 

 In the Transitions view, click the Edit Transition 
button. In the Properties view, drag the Duration 
value, or select it and type a new value. 

Note: Lengthening a transition’s duration means one or 
both clips must have enough trimmed frames to 
accommodate a longer transition. 

 
Figure 19 Trim-In icon and transition information 
in the Timeline 

 

To adjust the center point of a transition: 

1. Select the transition in the Timeline. 

2. In the Transitions view of the Tasks panel, click the Edit 
Transition button. 

3. In the preview area in the Properties view, drag the 
small circle to reposition the transition center 
(Figure 20). 

Note: Not all transitions have an adjustable center point. 

 
Figure 20 Default center (left) and repositioned 
center (right) 
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How to add video effects 

You can use effects to add a creative flair to your movie or to fix exposure or color problems, edit sound, or 
manipulate images. Adobe Premiere Elements comes with preset effects with which you can quickly and easily 
apply a preconfigured effect to footage. You can use included presets, create your own presets, or adjust and animate 
values as desired. 

You can animate the effects you add to clips by using presets that have predefined keyframe values, or you can 
create keyframes with custom values. Presets provide a quick, easy way to animate effects, while custom keyframes 
let you create more precise and complex animations. 

About effects 
After you’ve assembled a movie (arranging, deleting, and trimming clips), you can add polish to it by applying 
effects to clips (Figure 1). For example, an effect can alter the exposure or color of footage, manipulate sound, 
distort images, or add an artistic feel. All effects are preset to default settings so you can see the results of the effect 
as soon as you apply it. You can change these settings to suit your needs when you apply the effect. 

You can also use effects to rotate and animate a clip or to adjust its size and position within the frame. Adobe 
Premiere Elements also includes several preset effects you can use to quickly alter your footage. Most effects have 
adjustable properties; however, some effects, such as Black & White, do not. All effects are reversible, so if you 
don’t like the results of an effect, you can remove the effect at any time. 

 

 
Figure 1 Effects view in the Edit workspace 

This guide examines how to apply effects to a clip—specifically, how to use the cartoon special effect. This effect 
applies a cartoon-like style to scene (or part of a scene) for an entertaining special effect.  

Preview of 
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List of applied 
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Find, apply, and preview effects 
Available effects are listed in the Effects view and are organized into two main folders: Video Effects and Audio 
Effects. Effect presets (preconfigured effects) are stored in the Presets folder. If you create your own effect presets, 
they are stored in the My Presets folder. 

Within each folder, effects are grouped by type in nested folders. For example, the Blur And Sharpen folder contains 
effects that alter the clarity or focus of an image, such as Fast Blur and Sharpen. 

When you apply an effect to a clip, the effect is set to default values and is active for the duration of the clip. After 
you apply an effect, you can adjust its properties by clicking the Edit Effect button in the Effects view. You can 
make an effect start and stop at specific times or adjust the values of the effect over time by using keyframes. 

You can apply multiple effects to a clip, and you can apply the same effect numerous times to the same clip with 
different settings. Keep in mind, however, that the more effects you add, the more time it takes to render the final 
movie. If you decide an effect is not suitable for your project, you can easily delete it in the Effects view. 

To apply and preview a video effect: 

1. Open an Adobe Premiere Elements project. 

2. Click Edit in the Tasks panel, and click Effects to open 
the Effects view. 

3. Select the effect you want to apply. To locate an effect: 

• Choose an effect type from the first menu (Video 
Effects, Audio Effects, and so on), and then choose 
an effect category such as the NewBlue Cartoonr 
Plus Elements effect from the second menu 
(Figure 2) to view its contents. 

• In the search box, type the name of the effect you 
are looking for. The list displays all effects with 
names that match the letters and spaces you type. 
(Clear the text box to see all of the effect folders.) 

4. Select a clip or multiple clips in the Timeline or 
Sceneline, and do one of the following: 

• Select an effect and click the Apply button at the 
bottom of the Tasks panel. 

• Drag the effect to the clip in the Timeline, the 
Sceneline, or the Monitor panel. 

Note: To select nonconsecutive clips, Shift-click each 
clip. To select consecutive clips, click in the My Projects 
panel and drag a marquee around the clips you want. 

 

 
Figure 2 Selecting an effect category from the 
second menu in the Effects view 
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5. Click the Play button in the Monitor panel to preview 
the clip with the effect applied (Figure 3). 

6. To remove an effect, select the effect at the top of the 
Effects view, and then click the Trash Bin button 
(Figure 4).  

 
Figure 3 Preview the Cartoonr effect in the 
Monitor panel 

 
Figure 4 Effects view 

 

 

Trash 
Bin 
button 
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Changing effect properties 
Use the Effect Properties view to adjust effect properties. Open the Effect Properties view from the Effects view by 
clicking the Edit Effects button (or by choosing Window > Properties). 

The Effect Properties view includes a time ruler, a current-time indicator, zoom controls, controls for playing and 
looping audio clips, and a keyframe navigator. Unlike the time ruler in Timeline view, the time ruler in the Effect 
Properties view measures only a specific clip or transition. Click Show Keyframes to view the time ruler and the 
keyframe area, where you can adjust how an effect changes over time. 

In the Effect Properties view, you can view the entire length of a clip to which you apply an effect. Expand an effect 
to display the controls you use to change its properties. Controls can include underlined values, sliders, effect point 
icons, angle controls, menus, color swatches, the Eyedropper tool, and graphs. 

 

 
 

Figure 5 Effect Properties view in the Edit workspace 

 
Adjust effect properties 
You adjust properties for all effects in the Effect Properties view, using either the Sceneline or the Timeline. You 
can adjust Volume and Opacity effects in the Timeline as well. 

Note: You adjust the Motion effect directly in the Monitor panel. Standard effects that allow direct manipulation of 
clips in the Monitor panel include Corner Pin, Crop, Garbage Matte, Mirror, Transform, Twirl, and the GPU-based 
Ripple (Circular) effect. 

Clip 
preview Show/Hide 

Keyframes button 

Effect properties 

Delete button 
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To adjust a video effect: 

1. In the Timeline, select the clip that contains the effect 
you want to adjust. 

2. In the Effects view, click the Edit Effects button. 

3. In the Effect Properties view, expand the effect and do 
any of the following: 

• Drag the underlined value left or right. 

• Click the underlined value, enter a new value, and 
press Enter (Windows) or Return (Mac OS). 

• Drag the slider left or right (Figure 5). 

• Drag inside the angle control area. After you’ve 
clicked inside the angle control, you can drag 
outside of it to quickly change the values. 

4. If an effect is color-based, do either of the following: 

• If the color swatch is available, select a color in the 
Color dialog box, and then click OK. 

• If the Eyedropper tool is available, position it on the 
desired color anywhere on the screen, and then click 
to select the color. 

5. Sometimes, reordering effects can lead to an interesting 
effect in itself. To reorder effects, click an effect name in 
the Effect Properties view and drag it to a new location 
in the list. A black line appears when the effect is above 
or below another effect (Figure 6). When you release 
the mouse button, the effect appears in the new position. 

6. Preview your changes in the Monitor panel (Figure 7). 

Note: If you have a DV camcorder, you may be able to 
preview effects on a TV monitor. Connect the computer 
to your DV camcorder’s FireWire™ jack and connect 
the camcorder’s audio and video outputs to the TV. 
Previewing on a TV monitor is especially helpful for 
changes to color. 

 

 

 

Figure 6 Dragging an effect to a new location 

 

 

Figure 7 Preview the effect changes in the 
Monitor panel 
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How to add titles 
You can design custom titles and images with Adobe Premiere Elements. Titles are a valuable addition to a movie 
and can serve many purposes, from naming the people and places in your movie to providing movie-style credits at 
the beginning and end. You can create titles by using any font installed on your computer and create other graphic 
objects by using the title’s shape-creation tools. You can create images from any graphic or photograph on your 
computer and use them to further customize and enhance your movies. 

You can use the text and shape tools to create your titles from scratch, or you can use the included templates, preset 
text styles, and images to quickly create an attractive title. 

The title view is arranged over a suite of several related panels. You can dock the panels together or within other 
parts of the Adobe Premiere Elements interface (Figure 1). Adobe Premiere Elements optimizes the workspace for 
titles whenever you open or create a new title. 

 

 

 
 
 
 

Figure 1 Title tools and options in the Monitor panel and the Tasks panel 

Monitor panel Text Options 

Text Styles 

Drawing tools 



Adobe Premiere Elements 9 guide 

2 How to add titles © 2010 Adobe Systems Incorporated 

About titles 
You can open the title view and start a new title by using a menu command. Titles are embedded in the project file 
rather than being saved as independent files. Titles open in the Monitor panel. Reopen a title when you want to 
change it or when you want to duplicate it and base a new version on it. If you want to use a title in another project, 
you must open its project and export the title by using the File > Export > Title command. Then you can import it 
into another project as you would any other source file. 

To create a new title: 

1. Choose File > New > Title. 

 Note: You can also click the Title button in the Monitor. 

 A title appears centered on the currently chosen clip 
(Figure 2). 

2. Make one or more of the following changes using the 
Drawing tools in the right margin of the Monitor 
(Figure 3): 

• Click the Selection tool to change the location of 
the text. 

• Click the Type tool to change the wording of the 
text. 

• Click the Color Properties tool to change the color 
of the text. 

3. Use the Text Options section of the Tasks panel 
(Figure 4) to change one or more of the following 
attributes of the text: 

• Font or font style 

• Size 

• Alignment 

 Note: You can also select from a set of preformatted 
styles in the Text Styles section. 

 When you are finished, you can resume other editing 
tasks or repeat the preceding steps to create more titles. 

 Note: By default, titles are added with a duration of five 
seconds. To increase or decrease the amount of time that 
text displays, drag its borders in the Timeline. 

 
Figure 2 Adding a title 

 

 
Figure 3 Drawing tools in the Monitor 

 

 
Figure 4 Text Options and Text Styles sections 

Selection tool 

Color Properties tool 

Type tool 
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To edit a title: 

1. In the My Project panel, click Timeline. 

2. Double-click the title in the Timeline (Figure 5). 

 The text opens for editing in the Monitor (Figure 6). 

3. Make one or more of the following changes by using the 
buttons in the right margin of the Monitor: 

• Click the Selection tool to change the location of 
the text. 

• Click the Type tool to change the wording of the 
text. 

• Click the Color Properties tool to change the color 
of the text. 

4. Use the Text Options section to change one or more of 
the following attributes of the text: 

• Font or font style 

• Size 

• Alignment 

 Note: You can also select from a set of preformatted 
styles in the Text Styles section. 

5. Click on another clip in the Timeline to exit text editing 
mode. 

 
Figure 5 Timeline with title 
 

 
Figure 6 Text open for editing in the Monitor 
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About templates 
The title templates included with Adobe Premiere Elements provide several themes and preset layouts that make it 
quick and easy to design a title. Some templates include graphic images that may be pertinent to your movie’s 
subject matter, such as new baby or vacation themes. Others include placeholder text you can replace to create 
credits for your movie. Some templates are completely opaque; others have transparent backgrounds, depicted by 
dark gray and light gray squares, so you can see your video beneath the title. 

You can easily change every text or graphic object in the template by selecting an object and either deleting it or 
overwriting it. You can also add objects to the title. Once you modify the template, your unique version of the title is 
saved with your project without changing the template on which it is based. 

Note: When you apply a new template, the template content replaces any content currently in the title view. If you 
share templates between computers, make sure both computers have all the fonts, textures, and images used in the 
template. 

To create a new title from a template: 

1. In the Edit workspace, click the Titles button to preview 
templates. 

2. Browse to a template by choosing categories of 
templates from the two title menus (Figure 7). 

3. To apply a template, drag the template into the Monitor 
panel. 

 The template is available for editing in the Monitor 
panel. 

 Note: You can also double-click a template to open it in 
the Preview window. 

4. Modify the title as desired (Figure 8). 

 

 

 
Figure 7 Selecting a title template category 

 

 
Figure 8 Editing the selected title template 

Title menus 
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About styles 
You can save a combination of color properties and font characteristics as a style. You can then apply that style to 
any text or shape element in your title. You can save any number of styles. Thumbnails of the styles appear in the 
Properties view in the Tasks panel so you can quickly apply your custom styles across projects. Adobe Premiere 
Elements includes a library of styles you can use immediately (Figure 9). 

 
Figure 9 Properties view for text styles  

To create a style and display its swatch or name: 

1. Select an object that has the properties you want to save 
as a style (Figure 10). 

2. In the Properties view in the Tasks panel, click the Save 
Style button. 

 The Save Style dialog box appears (Figure 11). 

3. Type a name for the style and click OK. 

 The new style swatch displays the new style in the title 
Properties view. 

Note: Styles are always represented by a font, even if the 
object on which you based the style is a shape object.  

Figure 10 Select the object to save as a style 

 

 
Figure 11 Save Style dialog box 

Font and weight 

Alignment  

Bold, italic, and 
underline  

Text size, leading, 
and kerning 

Save style 
button 
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To apply a style to an object: 

1. Select the object to which you want to apply the style. 

2. In the Text Styles section of Properties view, click the 
style swatch you want to apply (Figure 12). 

 You may need to adjust the font size or reposition the 
text so that it fits within the frame. 

Note: To prevent the font type in the style from being 
applied to the font in your title, Alt-click (Windows) or 
Option-click (Mac OS) the style swatch.  

 

Figure 12 Text Styles section  

Formatting text 
Some object properties—such as fill color, shadow, and so on—are common to all objects you create in the title 
view, while other properties are unique to text objects. Text controls such as font, font style, and type alignment are 
in the Properties view in the Tasks panel (Figure 13). 

To modify a font, font style, or type alignment: 

Select the text and do the following in the Properties view in 
the Tasks panel: 

 To modify the font, choose a font from the Change 
Text Font menu in the Text Options section of the 
Properties view. 

 To modify font size and spacing, alter the 
parameters for the Change Text Size, Leading, and 
Kerning options. 

 To modify the font style, choose a font from the 
Change Font Style menu, or click one or more of 
the Bold, Italic, and Underline buttons. 

 To modify the font alignment, click one of the Left 
Align Text, Center Text, or Right Align Text 
buttons. 

 
Figure 13 Text Options in the Properties view 

 

Style to be applied 
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Adding shapes to titles 
You can also use the drawing tools in the Monitor panel to create a variety of shapes, such as rectangles, ellipses, 
and lines (Figure 14). 

 
Figure 14 Shape tools in the Monitor panel 

To create a shape: 

1. Select a shape tool. 

2. Do any of the following: 

 Drag to create the selected shape (Figure 15). 

 Shift-drag to constrain the shape’s aspect ratio (to 
create an oval that’s a precise circle or to create a 
rectangle that’s a precise square, for example). 

 Alt-drag (Windows) or Option-drag (Mac OS) to 
draw from the center of the shape. 

 Shift+Alt-drag (Windows) or Shift+Option-drag 
(Mac OS)  to constrain the aspect ratio and draw 
from the center. 

 Drag diagonally across the corner points to flip the 
shape diagonally as you draw. 

 Drag across, up, or down to flip the shape 
horizontally or vertically as you draw. 

3. Modify the new shape as needed. 

 
Figure 15 Shape created with the Ellipse tool  

 

Rectangle 

Ellipse 

Rounded Rectangle 
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Adding colors and shadows 
You can specify the color properties of each object or group of objects you create in the title view. The Color 
Properties dialog box includes controls for setting the color and type of an object’s stroke, fill, and shadow 
(Figure 16). To open the Color Properties dialog box, click the Color Properties button in the Monitor panel. 

Setting an object’s fill or stroke 

You can use the Color Properties dialog box to set an object’s fill or stroke. An object’s fill property defines the area 
within the contours of the object: the space inside a graphic object or within the outline of each character of a text 
object. You can also edit the outline, or stroke, of an object to which you’ve applied a style containing a stroke. 

Note: The Fill and Stroke boxes in the Color Properties dialog box are enabled only if you’ve applied a preset style 
from the title Properties Styles panel to the object. These styles contain fills and strokes you can edit. 

The Gradient menu provides options for applying a fill or stroke color. Color controls let you specify the color of a 
fill or stroke. Depending on the gradient type you select, additional color controls may appear. 
 

 
Figure 16 Color Properties dialog box 

Fill and Stroke 

Gradient menu 

Drop Shadow 
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To set the fill, stroke, and gradient: 

1. Select an object in the title, and in the Text Styles 
section of the Properties view, select a style that 
includes a fill. 

2. In the Monitor panel, click the Color Properties button 
(Figure 17). 

3. Modify any of the following properties: 

 Set the object’s fill color by using the Fill box. 

 Set the object’s stroke color by using the Stroke 
box. 

 In the Gradient menu, select the type of fill you 
want. If you select Linear Gradient, Radial 
Gradient, or 4 Color Gradient, color stop controls 
appear (Figure 18). 

 

 
Figure 17 Color Properties button 
 

 
Figure 18 Color stop controls 

Drop shadows 
You can add a drop shadow for any object you create in the Monitor panel. A drop shadow makes an object appear 
three-dimensional so it stands out from the background image. For example, adding a drop shadow to text can make 
the text more legible when superimposed over a complex background image. 

To create a drop shadow: 

1. Select an object and then click the Color Properties 
button. 

2. In the Color Properties dialog box, select the Drop 
Shadow option (Figure 19). 

3. Set any of the following: 

 Angle: Specifies the angle of the shadow in relation to 
the object. 

 Distance: Specifies the number of pixels the shadow is 
offset from the object. 

 Softness: Specifies how blurry or sharp the shadow 
appears.  

Figure 19 Color Properties dialog box  

Color 
Properties 
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Rolls and crawls 
Although static titles, graphics, and images may suffice for some projects, others require titles that move across the 
screen. (Titles that move vertically are called rolls. Titles that move horizontally are called crawls.) With Adobe 
Premiere Elements, you can easily create smooth, expert rolls and crawls. You can also make a title move along a 
custom path by keyframing locations for it at several points. 

To add roll or crawl options to selected text, select Title > Roll/Crawl Options in the menu bar (Figure 20).  

Note: The length of the title in the Timeline determines the speed of the roll or crawl. The more you increase the 
length of the title clip, the slower the movement will be. 

 
Figure 20 Title menu in the menu bar 

Roll and crawl options 
You can set the following options for rolls and crawls:  

Start Off Screen: Specifies that the roll or crawl begins out of view and moves into view. 

End Off Screen: Specifies that the roll or crawl continues until the objects are out of view. 

Preroll: Specifies the number of frames that play before the roll or crawl begins. 

Ease-In: Specifies the number of frames where the title rolls or crawls at a slowly increasing speed until it reaches 
the playback speed. 

Ease-Out: Specifies the number of frames where the title rolls or crawls at a slowly decreasing speed until the roll or 
crawl completes. 

Postroll: Specifies the number of frames that play after the roll or crawl completes. 

Crawl Left, Crawl Right: Specify the direction in which a crawl moves. 
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To create a rolling or crawling title: 

1. Do one of the following: 

 To create a rolling title, choose Title > New Title > 
Default Roll. 

 To create a crawling title, choose Title >  
New Title > Default Crawl. 

2. Create the text and graphic objects for the title 
(Figure 21). Use the scroll bar in the Monitor panel to 
view offscreen areas of the title.  

 When the title is added to the sequence, the hidden 
offscreen areas roll or crawl into view. 

 Note: For rolling credits, create a long text box by using 
the Vertical Type tool, and use alignment and leading to 
adjust the formatting. 

3. In the menu bar, select Title > Roll/Crawl Options. 

 The Roll/Crawl Options dialog box appears (Figure 22), 

4. Specify the appropriate direction and timing options, 
and then click OK. 

Note: You can specify a direction for crawling titles only. 

 
Figure 21 Title text 

 

 
Figure 22 Roll/Crawl Options dialog box 
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How to work with audio 

At least half of your movie’s impact comes from its use of sound. Adobe Premiere Elements provides the tools, such 
as the Audio Mixer and the Audio Meters, to create a high-quality sound mix. You can narrate clips or set beat 
markers while previewing in real time. You can add a soundtrack to your movie, and trim it to the proper length, or 
use SmartSound® soundtracks, which you customize to exactly fit your project. You can set the overall volume 
levels of clips and the relative volume levels within and among them. Finally, you can remove unwanted noises and 
add effects to the sounds in your movie. 

Premiere Elements supports the following soundtrack file formats:  

• Dolby AC-3 (.ac3) 

• Macintosh Audio AIFF (.aif, .aiff) 

• mp3 Audio (.mp3) 

• MPEG Audio (.mpeg, .mpg, .mpa, .mpe, .m2a) 

• QuickTime (.mov, .m4a) 

• Windows Media (.wma) 

• Windows WAVE (.wav) 

Adding an audio soundtrack 
To complement the sounds embedded in video clips and any narration you record, you can add audio clips to the 
Soundtrack track visible in the Timeline or Sceneline. You may need to scroll down the audio portion of the 
Timeline to see the Soundtrack. Video clips typically contain background music or recordings of environmental 
sound. 

To import audio and add a soundtrack: 

1. Choose File > Get Media From > Files And Folders 

2. Browse to the location of the audio file and click Open 
(Windows) or Import (Mac OS). 

 The audio file appears in the project (Figure 1). 

 
Figure 1 Audio file in project 
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3. Drag an audio clip from the Tasks panel into the 

Soundtrack track of the Sceneline where you want the 
audio clip to begin. 

 As you drag, a line indicates where the audio file will 
begin playing (Figure 2). 

 When you release the mouse button, the audio file is 
added as a track (Figure 3). 

4. To adjust the position of the soundtrack, drag it to the 
right or left. 

 Note: If the audio file is a narration, this may cause the 
narration to become out of sync with the video 

5. To adjust any audio level in the Sceneline, click an icon, 
such as the Video, Narration or Soundtrack icon, and 
then drag the volume slider that appears (Figure 4). 

6. To preview a soundtrack, select an audio clip in the 
Soundtrack track. 

7. Click the Play button in the Monitor panel. 

Adobe Premiere Elements previews the Soundtrack 
audio clip along with any audio and video clips above it 
in the Sceneline. 

8. To stop the preview, click the Pause button in the 
Monitor panel. 

 

 

 

 
 

Figure 2 Line indicates where added audio will 
begin 

 

 
Figure 3 Project Video, Narration, and 
Soundtrack tracks 

 

 
 

Figure 4 Soundtrack volume slider 

Audio begins here 

Click the icon 
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Confirm that the project audio is the same length as the video 

If you have imported an audio file, confirm that the project audio track is the same length as the video track. 

In the My Project panel, click Timeline, and check to see if the tracks are the same length (Figure 5). 

 
Figure 5 Project video and audio open in Timeline 
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Using SmartSound 
Included with Adobe Premiere Elements is the SmartSound® Quicktracks® plug-in. Use SmartSound Quicktracks 
to select from among a large collection of soundtracks for your video project. Then use SmartSound tools to 
customize the length of the soundtrack so that it corresponds exactly with the length of your movie. 

To use SmartSound Quicktracks on your video project, select SmartSound from the Audio Tools menu in Timeline, 
and follow the prompts. 

To add a SmartSound soundtrack: 

1. Open an Adobe Premiere Elements project, click the 
Edit tab in the Tasks panel.  

2. In the My Project panel, click Timeline. 

3. Select SmartSound from the Audio Tools menu on the 
Timeline (Figure 6).  

Note: First use of SmartSounds may require registration. 

 The SmartSound dialog box opens (Figure 7). 

 

 

 
Figure 6 Audio Tools menu on the Timeline 

 

 
Figure 7 SmartSound dialog box 

 

Audio Tools menu 
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4. Click the link that reads Click Here To Select Music. 

 The SmartSound Maestro dialog box opens (Figure 8). 

5. Select a SmartSound soundtrack from the list on the 
right and click Select. 

The SmartSound dialog box opens with options for the 
selected SmartSound soundtrack (Figure 9) 

6. Enter a length for the soundtrack.  

 This should match the length of the clip to which you 
want to apply the soundtrack.  

7. Select a variation for the SmartSound.  

 Variations determine tempo, intensity, and other 
characteristics of the sound. You can preview the sound 
in the dialog box.  

8. Select Loop to loop the segment.  

9. Click OK. 

The Exporting SmartSound Soundtrack dialog box 
opens. 

10. Brows to a location to export the file and click Save. 

The sound file is exported, and added to project. 

 

 

 
Figure 8 SmartSound Maestro dialog box 

 

 
Figure 9 SmartSound dialog box 

Creating narrations  
Using your computer’s microphone, you can narrate clips while previewing them in the Monitor panel. Your 
narration is then added to the Narration soundtrack visible in either the Timeline or Sceneline.  

For best results, confirm that your microphone is working correctly with your computer and Adobe Premiere 
Elements before narrating a clip. 

To narrate a clip: 

1. Plug a microphone into your computer’s microphone 
port. 

2. Choose Edit > Preferences > Audio Hardware 
(Windows) or Adobe Premiere Elements 9 > 
Preferences > Audio Hardware (Mac OS). 

3. From the Default Device menu, select your computer’s 
sound device, and click OK (Figure 10).  

 

 
 

Figure 10 Audio Hardware Preferences dialog 
box 
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4. Do one of the following: 

• In the Timeline, drag the current-time indicator in 
the Timeline to the point where you want the 
narration to begin. 

• In the Sceneline, select the clip you want to narrate. 
Then, in the Monitor panel, drag the current-time 
indicator to the point where you want the narration 
to begin. 

5. In the Timeline or Sceneline, select Add Narration from 
the Audio Tools menu (Figure 11). 

6. In the Record Voice Narration window, click the Mic 
Source button and select your sound device from the 
menu (Figure 12). 

7. For best results, turn off your computer speakers to 
prevent feedback. To monitor sound while you narrate, 
plug headphones into your computer and deselect Mute 
Audio While Recording. 

Note: If your speakers are turned on, move as close to 
the microphone as possible, and keep the microphone as 
far away from the speakers as possible to prevent 
feedback. 

8. Speak into the microphone at a conversational volume, 
and raise or lower the Input Volume Level slider until 
your loudest words light up the orange part of the 
meters. 

9. Click the Start Recording Narration button 

 Near the top of the Record Voice Narration window, a 
timer appears next to Start Recording In.  

10. When Start Recording In changes to Recording, speak 
your narration as the selected clip plays. 

11. When you finish narrating, click the Stop Recording 
Narration button. 

An audio clip containing your narration is added to the 
Media panel and to the Narration track in the Timeline 
or Sceneline (below the selected clip) (Figure 13). 

Note: If you do not click the Stop button, recording 
automatically stops at the beginning of the next file in 
the Narration track, or 30 seconds past the end of the last 
clip in the Timeline or Sceneline. 

12. To preview your recording, click the Go To Previous 
Narration button. Then click the Play Present Narration 
button. 

 

 
Figure 11 Audio Tools menu on the Sceneline 

 

 

 

 
 

Figure 12 Record Voice Narration dialog box 

 

 
Figure 13 Narration audio clip in the Narration 
track in the Sceneline 
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13. To continue recording from the position of the current-
time indicator, click the Start Recording Narration 
button again. 

This new recording overwrites any narrations that are 
traced over by the current-time indicator in the Narration 
track. 

14. Click the Pause Present Narration button at any time to 
stop the preview. 

15. To discard a narration, click the Delete Present 
Narration button (Figure 12).  

 The old narration clip is removed from the Timeline or 
Sceneline, but remains in the Project view of the Tasks 
panel. 

 

Balancing audio elements 
In Adobe Premiere Elements, volume changes are measured in decibels. A level of 0.0 dB is the original volume 
(not silence). Changing the level to a negative number reduces the volume, and changing the level to a positive 
number increases the volume. 

To control a clip’s volume, you can use the Volume graph—the yellow line running horizontally across the audio 
track of each clip (sometimes referred to as the volume rubberband)—or the Audio Mixer. You can use the Audio 
Meters window to view the overall audio volume for your project. 

Consider the following guidelines when adjusting volume levels: 

• If you combine particularly loud audio clips on multiple tracks, clipping (a staccato distortion) may occur. 
To avoid clipping, reduce volume levels. 

• If you need to adjust the volume separately in different parts of a clip (for example, one person’s voice is 
faint, while later another’s is too loud), you can use keyframes to vary the volume throughout the clip. 

• If the original level of a clip is much too high or low, you can change the input level. However, adjusting 
the input level will not remove any distortion that may have resulted from recording the clip too high. In 
those cases, it is best to re-record the clip. 
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Adjusting volume and mixing audio in the Audio Mixer 

Use the Audio Mixer to adjust audio balance and volume for different tracks in your project (Figure 14). You can 
adjust the balance and level of audio contained within your video clips, and within soundtrack and narration audio. 
For example, you may want to increase the volume of the narration and decrease the volume of the soundtrack at 
different points for emphasis or so that quiet voices can be heard above the music. 

You can adjust settings while listening to audio tracks and viewing video tracks. Each track in the Audio Mixer 
corresponds to an audio track in the Timeline or Sceneline, and is named accordingly. As you make adjustments, 
keyframes are added to the track. You can specify a default minimum interval for keyframes in the Audio 
preferences. 

 
Figure 14 Audio Mixer 
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To use the Audio Mixer: 

1. (Optional) Choose Edit > Preferences > Audio 
(Windows) or Adobe Premiere Elements 9 > 
Preferences > Audio (Mac OS) (Figure 15), and set a 
value between 1 and 2000 milliseconds for Minimum 
Time Interval Thinning to limit keyframes to intervals 
larger than that value. If you don’t want to hear audio 
while you scrub audio, deselect Play Audio While 
Scrubbing. 

2. In the Timeline or Sceneline, click the Audio Tools 
menu and select Audio Mix (Figure 16) or choose 
Window > Audio Mixer. 

3. In the Monitor window, drag the current-time indicator 
to where you want to start mixing audio. 

4. Click Play in the Monitor window and adjust the 
controls in the Audio Mixer (Figure 17) to 
automatically add keyframes to the track: 

• To adjust balance for a track, turn (drag) the 
Balance control left or right. 

• To increase the volume for a track, drag the Level 
control up or down. 

Note: You can specify the spacing of keyframes in the 
Audio preferences. 

To mute a track while mixing, click Mute. This option 
does not mute the track permanently—only while 
mixing. 

5. Close the Audio Mixer when you are finished mixing 
the audio. 

 

 
Figure 15 Audio Preferences dialog box 

 

 
Figure 16 Audio Tools menu on the Sceneline 

 

 
Figure 17 Adjust balance and levels in the Audio 
Mixer 
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SmartMix  
Sometimes the background music is loud and the dialogs in a clip are not audible. To ensure that the dialogs are 
easily heard, the volume of the background music must be lowered. SmartMix enables automatic adjustment of the 
volume of the background music (Figure 18). For best results, place dialog clips on the Audio 1 track or the 
Narration track (foreground tracks) and music on the Soundtrack track (background track). Adobe Premiere 
Elements analyzes clips on all foreground tracks for dialogs. Keyframes are then smartly/automatically created to 
lower the volume level to ensure that the dialog in the foreground track is audible. SmartMix adjustments apply to 
all audio clips on the Timeline, not just on the selected clip. When you use SmartMix on an audio track, keyframes 
you applied previously on the Soundtrack are deleted.  

 
Figure 18 SmartMixer panel 

To use SmartMix: 

1. Finish adding all audio elements to your project, 
including: 

• Audio from original video 

• Narration 

• Soundtracks (including SmartSound soundtracks) 

2. In the Timeline or Sceneline, click the Audio Tools 
menu and select SmartMix > Options (Figure 19). 

 The SmartMixer panel of the Mixer Options dialog box 
opens (Figure 20). Here, you set each audio track as 
foreground or background. 

4. Set options for each track. For example, if you want the 
narration always to be louder than the other tracks, set 
Narration as Foreground (Figure 20) and Audio 1 and 
Soundtrack to Background (where Audio 1 is the sound 
attached to the video). 

 

 
Figure 19 Audio Tools menu  

 

 
Figure 20 Setting Narration as Foreground  
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5. Click Apply. 

 Premiere Elements automatically adjusts the volume of 
each track so that the narration is always in the 
foreground. At points where the narration becomes 
quiet, Premiere Elements automatically raises the 
volume of the other tracks (Figure 21). 

6. To fine-tune audio track levels, expand the Audio Mixer 
in the Mixer Options panel. You can manually adjust 
Balance and  Levels for each of the audio tracks in your 
project  

 
 
 

Figure 21 SmartMix applied 

Repairing and enhancing audio  
Sometimes your video clip contains an audio track that is poorly recorded, or includes unwanted noise. You can 
repair problems and enhance audio using audio effects (Figure 22). You can also apply multiple audio effects to a 
clip. 
 

 
Figure 22 Properties for the NewBlue Cleaner AB audio effect 

 

Narration is quiet here 
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To repair and enhance an audio track: 

1. Click Edit in the Tasks panel, and click Effects to open 
the Effects view. 

2. Select the effect you want to apply. To locate an effect, 
choose Audio Effects from the menu at the top of the 
panel (Figure 23), or type the effect name in the search 
box.  

The Audio Effects appear in the Effects view. To repair 
an audio track, you might choose the NewBlue Noise 
Reducer from the selection in the Effects view 
(Figure24). 

3. Select a clip or multiple clips in the Timeline or the 
Sceneline, and do one of the following: 

• Click the Apply button at the bottom of the Tasks 
panel. 

• Drag the audio effect to the clip’s soundtrack in the 
Timeline or the Sceneline. 

Note: To select non-consecutive clips, Ctrl-click 
(Windows) or Command-click (Mac OS) each clip. To 
select consecutive clips, click in the My Projects panel, 
and drag a marquee around the selected clips. 

4. To preview the audio effect, perform the following 
steps: 

a. Click the Edit Effects button at the bottom of the 
Tasks panel. 

b. Expand the effect, and click the Play Only The 
Audio For This Clip button at the lower-left corner 
of the panel (Figure 25). 

Note: Audio playback controls are available only if the 
selected clip contains audio. 

5. To play audio as a continuous loop, click the Toggle 
Looping Audio Playback button before you click Play 
Audio For This Clip. 

6. To adjust the settings, expand the effect in the Properties 
view, and edit the settings per your requirement 
(Figure 25).  

Note: Each audio effect includes a bypass option that 
lets you turn the effect on or off as specified by the 
keyframes that you set. 

7. To accept and apply the new settings click Done in the 
Properties view of the Tasks panel (Figure 25).  

 

 
Figure 23 Effects menu in the Effects panel 

 

 
Figure 24 Audio Effects panel 

 

 
 

Figure 25 Properties for audio effects 

Play Only The 
Audio For This Clip  

Delete Effect 

Bypass 
option 
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8. To remove an effect, select the effect at the top of the 
Effects view, and then click the Trash button 
(Figure 26). 

9. You can apply other effects to enhance your audio file, 
such as Bass to boost the low decibel response of the 
soundtrack (Figure 27). 

 

 

 

 
 

Figure 26 Removing an effect from a project 

 

 
Figure 27 Properties for audio effects 

 

Trash button 
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Podcasting 
In Premiere Elements, you can create videos and podcast them directly to PodBean, a podcasting service. You can 
also create audio or video files to use in podcasts by exporting files you create in Adobe Premiere Elements. 

Podcasting with Podbean 
You can upload an audio or video podcast directly from Premiere Elements to the podcasting site Podbean. The 
content will automatically be formatted to meet Podbean’s requirements. 

To podcast with PodBean: 

1. Open the Share workspace in the Tasks panel and 
choose the Online option. 

2. Choose Podbean in the list at the top (Figure 1). 

3. Select from one of the following presets: 

• Podbean – Video High Quality 

• Podbean – Audio High Quality 

• Podbean – Video Medium Quality 

• Podbean – Audio Medium Quality 

4. Click Next. 

 The Podbean page appears (Figure 2). 

5. Enter information for your PodBean account and click 
Next. 

 Note: Podbean and Photoshop.com Online options only 
available in the United States. You must have previously 
signed up for a PodBean account to use this option. If 
you are not a member, click the Sign Up Now link at the 
bottom of the page. 

 

 

 
Figure 1 Online sharing section 

 

 
Figure 2 Podbean page 
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 The information page for your podcast appears 
(Figure 3). 

6. Enter the following information about your podcast: 

• Title 

• Description 

• Tags 

7. Select a category for your podcast from the Category 
menu. 

8. Click Next. 

 Premiere Elements uploads the video to the PodBean 
site. 

 

 
Figure 3 Information page for your podcast 

Exporting audio and video for podcasting 
If you want to create an audio file for use in a podcast, you should save it as an MP3 or AAC file. To export the 
audio from your movie in the format of your choice, use the Mobile Phones And Players option in the Share 
workspace in the Tasks panel. 

You select an export format by choosing the mobile device you want to target and then choosing a preset format for 
the exported file. Adobe Premiere Elements offers a number of preset formats optimized for specific devices. Use 
the provided presets for best results. If your project requires special settings, you can click the Advanced button and 
make changes.  

All mobile files are compressed by using the H.264 compression standard. To help you decide which preset to 
choose, each preset’s specific settings for file type, frame size, frame rate, audio frequency, file size, and duration 
are listed below the preset name. You can choose from the following formats when sharing to a mobile phone or 
player: 

Apple iPod And iPhone: Creates a file that plays back optimally from an iPod or iPhone. Choose iPod And 
iPhone High Quality or iPod And iPhone Medium Quality.  

Audio Podcast: Creates an audio file in MPEG-4 Movie format for optimal playback from an iPod or other 
audio player or mobile phone. Choose Audio Podcast – High Quality, Audio Podcast – Medium Quality, or 
MP3 Audio Podcast.  

Creative Zen: Creates a Windows Media Video (.wmv) file for optimal playback from either NTSC Creative 
Zen or PAL Creative Zen.  

Microsoft Zune: Creates a Windows Media Video (.wmv) file for optimal playback on Microsoft Zune.  

Pocket PC: Creates a Windows Media Video (.wmv) file for optimal playback on a Pocket PC.  

Smartphone: Creates a Windows Media Video (.wmv) file for optimal playback on a Smartphone. Choose a 
landscape or portrait preset.  

Sony PSP (PlayStation Portable): Creates an MPEG-4 Movie file for optimal playback on a Sony PSP device. 
Choose the High Quality, Medium Quality, or Widescreen preset.  

Mobile Phone: Creates an MPEG-4 Movie file for optimal playback on a mobile phone. Choose a preset based 
on the desired final frame size and whether you want a 3GP file or an MP4 file. 



 Adobe Premiere Elements 9 guide 

© 2010 Adobe Systems Incorporated Podcasting 3 

To export audio or video for podcasting: 

1. Consult the user guide for the device to determine the 
video file formats it supports. 

2. In the Share workspace in the Tasks panel, click Mobile 
Phones And Players. 

 Mobile view appears (Figure 4). 

2. Choose your phone or player from the list.  

 For example, to share video on the Apple iPod, choose 
Apple iPod And iPhone. 

3. Choose a quality level from the Presets popup menu.  

 As with other quality settings, file size increases as 
quality increases 

4. Enter a name for the file.  

 This is the name that will appear in both your computer 
and the phone/player. 

5. Click the Browse button to select a location for the file 
on your computer.  

 This is the location from which you will copy the file to 
a phone or player. 

6. Click the Advanced button to open the Export Settings 
dialog box (Figure 5). 

 You can use the Audio tab in the Export Settings dialog 
box to adjust the settings for the audio file. 

7. If you are exporting video, make sure the Export Video 
option is selected. If you are exporting audio only, make 
sure the Export Video option is not selected. 

8. Click OK to close the Export Settings dialog box. 

9. Click Save in Mobile view to export your audio or video 
file. 

 Premiere Elements renders the file and saves the file to 
your computer in the location you selected. As with 
other formats, rendering may take some time. 

 Once the rendering completes, you will see a 
confirmation message. To view the file, browse to its 
location. 

 Note: Depending on the file type, you may not be able 
to view the movie on your computer unless you have the 
correct player installed. 

 
Figure 4 Mobile view 

 

 
Figure 5 Export Settings dialog box with Video 
tab selected 
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How to share video 
You can share movies, stills, and audio in a variety of file types to the web, mobile devices, videotape, Video CDs, 
and Super Video CDs. You can also copy and save projects for editing and storage. 

The Share workspace in the Tasks panel (Figure 1) contains everything you need to save and share your finished 
project. You can save your project for viewing on the web, a mobile phone, a personal computer, DVD, Blu-ray 
Disc, and more. 

You can start a new share by clicking any of the share options: web DVD, Disc, Online, Personal Computer, Mobile 
Phones And Players, or Tape. Each of these options opens a view in the Tasks panel that provides specific options 
and settings for sharing to the respective media types. 

 
Figure 1 Disc options in the Share workspace 

web DVD: Build web DVD for viewing online or on a computer. 

Disc: Burn DVD and Blu-ray discs. To use this option, you must have a compatible disc burner installed. 

Online: Upload content to YouTube, Podbean (United States only), Photoshop.com (United States only), or 
your personal website. For online services, content is automatically formatted to the site’s requirements. For 
your personal website, you use FTP (File Transfer Protocol). 

Computer: Create video to be viewed by others on their computers. You can select from a wide range of 
formats, including Adobe Flash Video, MPEG-2, Windows Media File, QuickTime video, or AVI. The format 
you choose depends on such factors as the platform (Windows Media Files, for example, cannot be played in 
Mac OS without a plug-in), quality level (AVI or MPEG-2 are the highest quality), and file size (Adobe Flash 
Video, QuickTime, and Windows Media Format all provide relatively small file sizes). 

Mobile Phones And Players: Export video for viewing on an iPod, Zune, Smart Phone, PSP, or other mobile 
device. Premiere Elements automatically chooses settings for selected devices, while allowing you to adjust 
other settings, such as audio and video quality. 

Tape: Record video to DV or HDV tape, using a camcorder or similar device connected to your computer. This 
is a good option for storing high-quality video you want to work with later but that takes up too much room on 
your computer. 

Note: The Share workspace simplifies sharing and exporting by providing presets of the most commonly used 
formats and settings. If you want to specify unique settings for any format, you can click Advanced options and 
make changes. You can also use the export commands in the File menu, if desired. 
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Create DVD files for web 
web DVD files are DVD files played online. You can share your movie clips as web DVD files that can be 
embedded within web pages. The movie clips are exported in the Flash format. 

To create web DVD files for desktop: 

1. Click the Share tab in the Tasks panel (Figure 1). 

2. Click web DVD. 

web DVD view opens (Figure 2). 

3. Select Save To Folder On Computer. 

4. Select a preset from the Presets menu (Figure 3). 

5. In Project Name, enter a name for your project. 

6. In Save In, click Browse to select a location for the 
DVD output files. 

7. Click the Build button to create the web DVD. 

 The Build Completed message appears after the build is 
complete.  

8. Click the link to preview the generated web DVD file in 
your browser (Figure 4). 

 
Figure 2 web DVD view 

 

 
Figure 3 web DVD Presets menu 

 

 
Figure 4 Viewing the web DVD file 
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Sharing to a DVD 
DVDs are ideal for large projects and generally have the highest quality of any option. Depending on the complexity 
and length of the project and your computer speed, encoding (compressing) video and audio for a disc can take 
hours. If you plan to burn multiple discs with the same content and quality, you can save time by burning them in 
the same session, which compresses the project only once. 

To share to a DVD: 

1. Connect and turn on all external DVD or Blu-ray 
burners. 

2. In the Share workspace in the Tasks panel, click Disc. 

Disc view appears (Figure 5). 

3. In Disc view, choose either DVD or Blu-ray from the 
menu. 

4. Select Disc as the Burn To option. 

5. Type a name for the disc.  

 This name appears in Windows if you insert the disc 
into a computer after the DVD burn has been completed. 
(The default name is a date stamp in 24-hour format: 
YYYYMMDD_hhmmss.) 

6. Select a burner from the Burner Location menu. 

7. Make sure that a compatible disc is inserted in the drive. 
If you insert a disc, click Rescan to check all connected 
burners for valid media. 

8. In the Copies box, enter the number of discs you want to 
burn during this session.  

 You are prompted to insert new discs until all have been 
burned. Encoding the video and audio takes place only 
once. 

9. For Presets, select the option for the television standard 
used in the geographic location of your audience. 

• NTSC Dolby DVD (Standard view; United States 
and other countries that use the NTSC standard) 

• NTSC Dolby Widescreen (16 x 9 view; United 
States and other countries that use the NTSC 
standard) 

• PAL Dolby DVD (Standard view; United Kingdom 
and other countries that use the PAL standard) 

• PAL Dolby Widescreen (16 x 9 view; United States 
and other countries that use the PAL standard) 

 
Figure 5 Disc view 
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10.  (Optional) Select Fit Contents To Available Space. If 
burning to a DVD, you can deselect this option and drag 
the slider to choose the video quality you want. (By 
default, this option is selected for DVD, and deselected 
for Blu-ray.) 

11. Click Burn to begin converting your project to the DVD 
or Blu-ray format and burning the disc. If you are 
burning a DVD, and a burner is not available, you can 
burn to a DVD folder, and then burn the resulting files 
to DVD when the burner is available. 

The Build Completed message appears after the build is 
complete (Figure 6). 

Note: Encoding the video and audio for disc output can take 
several hours. 

 
Figure 6 Burn completed message in DVD panel 

Sharing to the web 
Adobe Premiere Elements enables you to export your movie in formats suitable for delivery through the Internet. 
Using the Share workspace in the Tasks panel, you can upload your video directly to the web. Adobe Premiere 
Elements provides preset formats such as Adobe Flash Video (.flv), Flash Renamed MP4 file (.f4v), and QuickTime 
(.mov), which are commonly used to embed video into web pages and web applications. 

The Flash Video For Web preset covers the requirements of most servers and the bandwidth and player options 
available to most viewers. Using a preset is the quickest way to export your movie. You can also customize the 
settings to match a specific situation. Remember, however, to make sure that the data rate of your movie is 
appropriate for the intended playback medium.  

Adobe Premiere Elements makes it simple to quickly upload your movies directly to YouTube. You can set up an 
account and specify quality settings the first time you upload to YouTube. 

To share a movie on YouTube: 

1. Click Share in the Tasks panel, and click Online. 

 Online view appears (Figure 2). 

2. Choose YouTube from the list at the top.  

 Adobe Premiere Elements uses the Flash Video For 
YouTube preset for all YouTube files. 

 

 
Figure 7 Options in Online view 
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3. Click Next and log in to YouTube (Figure 8). If it is 
your first time uploading to YouTube, click Sign Up 
Now and register. Then log in. 

4. Click Next. 

5. Enter the required information about your project: Title, 
Description, Tags, and Category (Figure 9). Then click 
Next. 

6. Choose whether you want to allow the public to view 
your project, and then click Share. 

The Share Complete message appears after the share is 
finished uploading (Figure 10). 

   
Figure 8 Log in to YouTube  

 

 
Figure 9 Movie information  

 

 
Figure 10 Share Complete message  
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7. When the share is complete, the location appears in the 
Share workspace. You can choose View My Video to 
open YouTube and watch your video (Figure 11), or 
Tell Friends to send an e-mail about your new posting. 

8. To return to the main Share workspace, click Done. 

 

 

 

 
Figure 11 Viewing the video on YouTube 

Sharing to your computer 
The video you edit in the Timeline or Sceneline is not available as an independent video file until you export, or 
share, it to a video format. After export, you can play it back on your computer, view it in other media player or 
editing programs, and move it to other computers. 

Sharing a movie for computer playback generally creates files with data rates and file sizes that exceed the limits for 
successful playback on the Internet, VCD, SVCD, DVD, or handheld devices.  
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To share to your computer: 

1. Click Share in the Tasks panel, and then click Computer. 

 Computer view appears (Figure 12). 

2. Choose a format from the list.  

 For example, if you are distributing and viewing the 
project on the web, you might choose Adobe Flash 
Video. 

3. Choose a quality level from the Presets menu.  

 As with other quality settings, file size increases as 
quality increases. 

4. Enter a name for the file.  

 This is the name that will appear on your computer. 

5. Click the Browse button to select a location for the file 
on your computer. 

6. Click Save. 

 Premiere Elements renders the file and saves the file to 
your computer in the location you selected. As with 
other formats, rendering may take some time. 

 Once the rendering completes, you will see a 
confirmation message. To view the file, browse to its 
location. 

 
Figure 12 Computer view 

Sharing to a mobile phone or player 
With Premiere Elements, you can share projects to a range of handheld media players and mobile phones so viewers 
can watch your movies on these players. 

With this option, you first format the project and save it to your computer. Later, you can move the file to a media 
player or mobile phone. 

Each player or phone has particular requirements. For more information on the specifications for your desired player 
or phone, go to the manufacturer’s website. 
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To share to a mobile phone or player: 

1. Consult the user guide for the device to determine the 
video file formats it supports. 

2. In the Share workspace in the Tasks panel, click Mobile 
Phones And Players. 

 Mobile view appears (Figure 13). 

2. Choose your phone or player from the list.  

 For example, to share video on the Apple iPod, choose 
Apple iPod And iPhone. 

3. Choose a quality level from the Presets popup menu.  

 As with other quality settings, file size increases as 
quality increases 

4. Enter a name for the file.  

 This is the name that will appear in both your computer 
and the phone/player. 

5. Click the Browse button to select a location for the file 
on your computer.  

 This is the location from which you will copy the file to 
a phone or player. 

6. Click the Advanced button to open the Export Settings 
dialog box (Figure 14). 

 You can use the Audio tab in the Export Settings dialog 
box to adjust the settings for the audio file. 

7. If you are exporting video, make sure the Export Video 
option is selected. If you are exporting audio only, make 
sure the Export Video option is not selected. 

8. Click OK to close the Export Settings dialog box. 

9. Click Save in Mobile view to export your audio or video 
file. 

 Premiere Elements renders the file and saves the file to 
your computer in the location you selected. As with 
other formats, rendering may take some time. 

 Once the rendering completes, you will see a 
confirmation message. To view the file, browse to its 
location. 

 Note: Depending on the file type, you may not be able 
to view the movie on your computer unless you have the 
correct player installed. 

 
Figure 13 Mobile view 

 

 
Figure 14 Export Settings dialog box with Video 
tab selected 
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